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 Introduction Nothing is difficult once you have learned it. That applies to Excel as well, and once you have learned it, you will be able to do things you never dreamed of! You will be able, to make calculations more complex than NASA did when they sent the first man to the moon! It may sound like big words, but in the case of Excel - or spreadsheet programs in general - it is quite true. Spreadsheets can process large amounts of data and give you the calculation results in no time. And when the calculations are made, you can have them presented as beautiful tables and graphs. I know of many who are reluctant to engage with Excel because they find it difficult. Granted, Excel is a program that requires some basic skills before embarking on it, and if you have no feeling for or interest in numbers it can appear meaningless. With word-processing programs like Word, you can basically just start typing right away, but with spreadsheets it is a different story. In return, you can achieve some pretty amazing results when you master Excel at a reasonable level. I have made such diverse things as budgets, accounting, production planning, production simulation, energy accounting and quality statistics in Excel, and as long as it involves numbers, the only limit is your imagination. Excel is a program that you never quite finish learning about. I have used Excel for many years and have tried most things, and I still find it challenging. Even if you are familiar with all the basic functions, you will find occasion to continue challenging yourself and find new things you can squeeze out of the program. And when the program cannot perform the tasks you require, it also has an entire programming language, enabling you to make your own small programs inside Excel! I would think Excel is the program in the Office package which over time has had the greatest impact on the business sector. Word may be far more sophisticated than even the most advanced typewriter, but Excel enables you to make calculations in a few hours that previously would have taken several days, weeks or even years to perform. Being a "numbers nerd" I find it hard to hide my enthusiasm for Excel. I hope that, after you have finished reading this book, you will also have discovered how powerful a tool you now have at your disposal.
 
 A Small Reader’s Guide If you have not worked with Excel before, I would recommend that you read the entire book from one end to another. You can subsequently use it as a reference. I have tried to arrange the book in a logical manner so you can quickly find a chapter that deals with a problem similar to the one you are trying to solve.
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 If you have already worked a lot with Excel, you can probably skip some of the first sections if you want to get to the really "cool" stuff as quickly as possible. The book has a number of progressive exercises that illustrate what Excel can do. Of course you can just read through them, but I would advise you to sit down by a computer and perform them as described. It is simply a much better way to learn, and it allows you to experiment beyond the requirements of the exercises. I have chosen to keep the exercises very simple, using very little data. These exercises can in some cases appear absurd, but the purpose is for you to understand the various points, so that you can exploit the functionality for more complex tasks. I have therefore taken great pains to avoid involving you in something too difficult. There is nothing worse than having to give up on an exercise because you are stuck. If you get stuck anyway, I recommend that you call a good friend or your clever nephew. There is always someone nearby who has worked with Excel and can help you out. Many exercises require that you type a few things into the spreadsheet first. It is important that you type in these things exactly as described. If I ask you to write something in cell B2, and you type it in cell C2, you will probably have problems with the exercise later. The same goes for spelling. Always spell words in exactly the same way I did when you type them into the sheet. When I ask you to "click" on something, it is a click with the left mouse button. A double click is two fast clicks with the left mouse button. If I want you to click the right mouse button, I call it a "right-click". Buttons and menus that you can / must click are always written in underlined font. This means that when you see underlined text you should be able to find something similar on the screen that you can click on. If I want you to type something in your spreadsheet, it will appear like this:
 
 Type=sum(a1:b3) Now we are ready to start up the program and look at all its wonderful features!
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 1. What is New in Excel 2007 In the last several versions the new features in Excel have mostly been cosmetic in nature, but in version 2007 there are many new things. There have been many improvements in appearance, but Microsoft has in this version also introduced many functional improvements.
 
 1.1 Ribbons and Tabs Like the other applications in the Office package, Excel has also gotten a new and smarter look. The first thing that catches the eye is that the traditional menu bars and toolbars have been replaced by the new "Ribbon". The Ribbon contains Tabs, and each Tab contains buttons for various functions that were previously located in the menus and toolbars. The Ribbon is far more visual and task-oriented and adapts constantly to the activity you are engaged in. If you have been accustomed to working with menus and toolbars for many years, it takes a while to get used to the Ribbon, but I must admit that after some time I have been really pleased with the new system. It appears more coherent, and it is not as messy as the toolbars sometimes tend to be.
 
 1.2 Larger Workspace It has always been possible to make large spreadsheets in Excel. In previous versions you could have 65,536 rows and 256 columns. This made for pretty large spreadsheets, but you had better sit down for this: In Excel 2007, you have up to 1,048,576 rows and 16,384 columns!
 
 1.3 More Colours In previous versions you had only a few colours to choose from when you had to put background colour in the cells. Now you can choose between 16 million different colours. You can also create colour transitions inside the cells. It gives you unprecedented opportunities to create worksheets that look nice and inviting.
 
 1.4 Colour Themes and Styles Now you can use predefined colour themes in Excel. This feature is known from Word and Power Point, where the programs help you format your entire document, so everything appears smooth and harmonious. This is also possible in Excel now. If you make charts, they will automatically be consistent with the colour theme that is selected
 
 1.5 Improved Pivot Tables The "Pivot Table" function has been one of the features that have been least accessible. Microsoft has radically changed the way to set up a pivot table so it is easier and more intuitive to use.
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 1.6 Improved Conditional Formatting The "Conditional Formatting" function has been significantly improved. There are more opportunities for highlighting of, for example, "Top 10", and it is possible to colour the cells according to cell value
 
 1.7 More and Better-Looking Charts Excel 2007 has no new basic chart types, but there are now more variations of existing ones. Formatting has been improved, and you can, for example, add soft shadows behind your columns, which gives a nice effect. If you do not choose the colours in a chart yourself, the colours in the spreadsheet colour theme will be automatically applied, so everything appears harmoniously.
 
 1.8 New File Format Excel uses a new file format which is not compatible with earlier versions. If you have worked with the program before, you will know that the file name ends in ". Xls". In Excel 2007 the file name ends with ".Xlsx". For the technically minded, I can reveal that it is an XML-based format, which gives smaller file sizes and better opportunities for integration with other programs. You can still save your spreadsheets in the old format, but be aware that some functionality may be lost.
 
 1.9 Where can I find the Old Buttons? If you are familiar with older versions of Excel, you will probably have trouble finding some of the old features. This is obviously because the menu bar and toolbars have been replaced with the "Ribbon". It might be a little confusing, but I'll try to list the main functions, so you can find them quickly. New, Open, Save, Save As and Close are located in the Office Button at the top left. The Save feature is also available as standard in the Quick Access Toolbar, located just to the right of the Office Button. Preview is also available in the Office Button under menu item Print. The Drawing toolbar no longer exists. It has been replaced by the Shapes and SmartArt buttons under the Insert tab in the Ribbon. The Insert symbol is also located in the Ribbon under the Insert tab. This button is simply called Symbol. Normal view and Page Break preview are there as small buttons at the bottom right corner of the screen. The Insert function has been replaced by the Formulas Tab in the Ribbon. This is a clear improvement, but if you prefer the old dialog box, you can get it by clicking on FX on the formula bar. 12
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 2. First Look at Excel In this section we will review the basic structure of Excel 2007. You start the program by clicking the Windows Start button at the bottom left, then click Programs. In the programs menu you will find a folder called Microsoft Office, which is where Excel is located.
 
 Figure 1: Excel’s structure. Currently, cell A1 has been selected. I have highlighted column H and row 13. The cell where column H and row 13 meet is called H13.
 
 2.1 The Screen and its Elements When you start Excel, you will automatically start in a new, blank workbook. Excel basically looks and works the same way it has in the last 4-5 versions. If you already know Excel, you can use it exactly as you have always done. Nevertheless, there have been some changes and improvements different places, and they are not just cosmetic.
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 2.1.1 Workbooks and Spreadsheets An ordinary Excel file is called a "Workbook" and can contain different things. The most important thing is that it can contain worksheets, but it may also contain chart sheets and small programs that you can do yourself. The most important thing is to be aware that an Excel file is not necessarily just a spreadsheet but a workbook that can contain many spreadsheets and charts. 2.1.2 The Ribbon The Ribbon with its Tabs and buttons is located at the top. The Ribbon is the most obvious change in Excel compared to previous versions, and it replaces the old menus and toolbars. But the Ribbon does not replace only the menus and toolbars. Many functions which previously required that you filled out various dialog boxes have become more directly accessible in the Ribbon In my case it took some time to get used to the Ribbon because I have been accustomed to the menu bar and toolbars for many years. The Ribbon is far more visual and task-oriented, and it looks very nice. Whether it is an improvement is perhaps a matter of taste. It was difficult for me to get used to it after so many years with the menu bar and toolbars.
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 But somehow, I have become quite fond of it. The old toolbar had a tendency to "mess around" at the top of the screen, whereas the Ribbon stays in place, so when you need a button, it will be in the same place as last time you used it. There are also many exciting new features for formatting and graphics, and the old shortcut keys also still work.
 
 Figure 2: A section of the Ribbon.
 
 It is also a great improvement that small "tool tips" pop up when you point to a button that has been upgraded. They have nice graphics and more detailed explanations of what the button does. It is a great help when you want to know the program. 2.1.3 The Office Button In the top left corner of the screen you will find the round Office Button. It corresponds by and large to the old "File" menu. If you click on the Office button a menu pops up. This is the menu you must enter when you want to create a new blank spreadsheet, and when you need to save it.
 
 Figure 4: Clicking on the Office Button opens this menu.
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 It is also via the Office Button that you can find Excel Options, where you can change the settings for how Excel should work. 2.1.4 Quick Access The small discrete toolbar "Quick Access", where with a single click you can save, undo, etc., is located just to the right of the Office Button. "Quick Access" can be customised so that you can choose the features that suit you best. You do this by right-clicking on a button and choosing Customize Quick Access Toolbar. Alternatively you can click the small arrow to the right of the toolbar, which enables you to quickly select and deselect various features. 2.1.5 The Workspace The workspace is located underneath the Ribbon, and this is where you have your spreadsheet. The spreadsheet is a huge table with "columns" and "rows". The columns are named with letters in the "column headings", and the rows are labelled with row numbers in the “row headings." By clicking on a column heading, you can select the cells in the whole column, and the same is true if you click on a row heading. The “Corner” is located in the top left corner of the worksheet. By clicking on the corner you can select all the cells in the entire worksheet. The cells are the basic elements of the worksheet; this is where we type in our data and formulas. Wherever a row and a column meet, we have a "cell". Each cell in the worksheet has a unique name. For example, the cell located where column C and row 4 meet is called "C4". A cell can contain numbers, words and formulas. Formulas are a kind of commands that you type into a cell, which make the cell display the result of a calculation. You do not have to worry about that yet, I promise we will return to it in more detail. 2.1.6 Sheet Tabs The “Sheet Tabs” are located just below the worksheet, on the left side. This is because you can work with multiple worksheets at once. An Excel file is therefore also called a ”Workbook”, because it is similar to a folder containing a number of spreadsheets.
 
 Figure 5: The Sheet Tabs.
 
 The Sheet Tabs are by default named "Sheet1", "Sheet2" etc., but you can give them more meaningful names yourself. You can also delete and add Sheet Tabs, and thus spreadsheets. If you right-click on one of the Sheet Tabs, a menu pops up giving you the opportunity to do various different things. You can add, delete and copy Sheet Tabs, and thus the spreadsheets they represent. You can also change the order of the Tabs and give each Tab its own colour, which can facilitate the overview.
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 2.1.7 Display Buttons You can use the display buttons to adjust the way you view the spreadsheet. When you start a new spreadsheet, it is displayed in "Normal View", but you can also view it as a "Page Impression", which is somewhat similar to the way it would look if you were to print the sheet. "Show page breaks" is another option, where you can view and adjust the page breaks in the print-out.
 
 Figure 6: The display buttons.
 
 Finally, there is the zoom function, which allows you to enlarge or reduce the view of the sheet. The zoom function does not affect how the spreadsheet appears on a print-out. The zoom function is easy to use, but a better way in my opinion is to hold down the CTRL key on your keyboard while scrolling up and down with the scroll wheel on your mouse. Of course this requires that you have a mouse with a scroll wheel.
 
 Please click the advert
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 2.1.8 Start a New Spreadsheet When Excel starts up, the program will display a new, blank workbook. This is fine, but you do not always have to build everything up from scratch. Alternatively, you can start a new spreadsheet manually, using various templates. 1. Click on the Office Button in the top left corner of the screen. 2. Click on New. You will now have the opportunity to choose which template you want to use. The templates are organised in categories on the left side, which you can click on. When later in the book you have to perform an exercise, and I ask that you start with a blank worksheet, select the Empty and Latest category, and then the template Blank Spreadsheet. Later, when you get more familiar with it, you can try different templates.
 
 Figure 7: There are many possibilities when you want to start a new spreadsheet.
 
 Templates for invoicing budgeting and even monitoring of blood pressure have already been installed. If you do not think the preinstalled templates are enough, it is possible to download many more via the categories under "Microsoft Office Online".
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 2.2 Navigating the spreadsheet You can use both mouse and keyboard to navigate the worksheet, but I recommend that you practice using the keyboard. It is a faster and ergonomically better solution. You'll need to move things around a lot in the spreadsheet, and if you always use the mouse you could easily develop a "mouse-arm"
 
 Figure 8: Here B2 is the active cell.
 
 Using the keyboard to move around has other advantages which I shall return to later. There is always one, and only one, active cell in the spreadsheet. It is identified by a thick black border all around it called the "cell pointer". You can choose a second active cell using the arrow keys or the mouse. Try pressing lightly on the arrow keys on the keyboard to move the cursor. 2.2.1 Navigating Large Spreadsheets When you navigate large spreadsheets, it becomes really difficult to use the mouse. You can move quickly to specific locations in a spreadsheet using the keyboard. If you press down the CTRL key and press the HOME key on the keyboard, the cursor moves to cell A1. If you hold down the CTRL key and use the arrow keys, you can skip to "where something is happening." It could, for example, be the outer edge of a table. If you have a table with 1000 rows and 50 columns in your spreadsheet, pressing the down arrow while you press down the CTRL key will take you to the last row of the table. Similarly, the up arrow will take you to the top. The principle is the same for moving right and left. This can also be used for selection of cells. If, in addition to pressing down the CTRL key, press down the Shift key as well, the cells will be selected. 2.2.2 Cell Pointer and Auto Fill If you take a close look at the cell pointer, you'll notice a small black square in the lower right corner of the cursor. This is the location of a feature with the Figur 9: The cell pointer. Note the littel black box in awkward name "Auto Fill". Auto Fill can be used via the mouse if you need to the bottom right corner. quickly copy some cells. When you point to the little black square with the mouse the mouse cursor changes to a small black cross. Keep the left mouse button down and move the mouse until you have marked some cells, then release the mouse button again.
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 Several things can happen when you do this. Either a simple copying of content from the active cell will take place or a "series" will be introduced. If, for example, you typed "Monday" in the active cell and used Auto Fill to copy it, the subsequent cells will read "Tuesday", "Wednesday", etc. This is one kind of series. Excel has a number of predefined ranges for particular weekdays and months. You can also create your own series, and we will come back to that later in the book.
 
 2.3 Writing in the Cells Try typing some numbers and text in different cells. When you finish typing something into a cell, press the ENTER key on the keyboard. The cell below the cell you just typed in will become the active cell. Note also that if you write text in a cell, the text will be aligned to the left. If you type in numbers, the figure will be adjusted to the right. If you want to change something in a cell, you can double-click on it, which enables you to change the content. If it is the active cell you want to change, you can also press F2 on your keyboard.
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 If you merely wish to add something new you just double-click on the active cell.
 
 Figure 10: The Formula Bar displays the content of the cell.
 
 Also note the "Formula Bar", as shown in Figure 11. It is currently showing what you type into the cells, and may not seem especially important right now. But later, when you use formulas in some of the cells, the Formula Bar will show what kind of formula that is used in the active cell, while the active cell displays the result.
 
 2.4 Adaptation of Cell Size The cells are exactly the same from the start, but this can be changed. You can change the cell size by changing the row height and column width. Try moving your mouse over the column headers (A, B, C, etc.). You will notice that the mouse cursor changes when it approaches a new column. When it does, you can press the left mouse button down while moving the mouse to adjust column width. The same method can be used to change the row height. Instead of clicking and dragging with your mouse, you can double-click it. This will adjust the column width so that it is just wide enough to show the largest cell in the column. You can experiment with this yourself. This method can also be used to adjust the row height.
 
 2.5 Selecting Cells To select a single cell, just move the cell pointer to it so that it becomes the active cell. If you want to select multiple cells, there are two ways to do it. 1. Point to a cell with the mouse, press the left mouse button down and drag the mouse, by which an area will be selected. Release the left mouse button when you have selected the area you wanted. The cell you clicked on first will be the active cell. 2. Move the cursor to the corner of the area you want to select. Hold down the Shift key on your keyboard and press the arrow keys. As long as you hold down the Shift the selection will be adjusted. Release the Shift key when you are done selecting.
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 2.5.1 Compound Selection You can also select multiple independent fields at once. Here you will have to use both mouse and keyboard simultaneously. You must hold down the CTRL key on your keyboard, then select the desired fields with the mouse. Experiment a little with it yourself. 2.5.2 Navigating Inside a Selection If you have selected an area and then press one of the arrow keys on the keyboard, the selection will disappear. That is not always what we want, so instead, use the TAB key and ENTER key on your keyboard to move to the right and downward respectively. You can use the same keys to move left and upwards by pressing down the SHIFT key simultaneously.
 
 22
 
 3. Calculations
 
 Excel 2007
 
 3. Calculations The primary objective of Excel is to count, and the program is actually quite good at it! To make a calculation you must write a "formula". The formula should be written into the cell showing the result. A formula is a structured piece of text that tells Excel what it has to calculate. It is not that hard to learn in small steps, so let us write a simple little formula to calculate the result of 2+3.
 
 3.1 Formulas In Excel one always starts a formula by typing an equal sign =. It is a sign that tells Excel that what is in the cell is a formula and not a text or a number. When you are finished typing the formula, Excel will display the result in the cell instead of the formula you have written.
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 1. Place the cursor in a random cell and type = 2+3 (See Figure 12).
 
 Figure 11: Your first formula.
 
 2. Press the ENTER key on the keyboard. It should now read ”5” in the cell in which you wrote the formula. Move the cursor to the cell, and note that the Formula Bar still reads ”=2+3”, like shown in Figure 12.
 
 Figure 12: The result of your formula is displayed in the cell, and the formula is displayed in the Formula Bar.
 
 If you want to change the formula, you can click on the Formula Bar to edit it. Alternatively, you can doubleclick the cell or press the F2 key on your keyboard. 3.1.1 Operators You can use the four methods of calculation (plus +, minus -, multiply * and divide /) in this way. You can also use parentheses if necessary. For example, 2 +3 * 4 is not the same as (2 +3) * 4. In this respect Excel follows the general calculation rules. Potency is calculated by using the sign "^", written by holding down SHIFT on your keyboard and pressing the key between Z and ENTER. For example, 23 is written 2^3. So far, you are probably not all that impressed with Excel's calculation capacity. Actually, we could make the above calculation much easier by using a simple pocket calculator, and it is only to show what a basic formula is.
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 3.2 Formulas with references To make everything right, we must take advantage of "references" in our formulas. References are made to values in other cells. Delete everything you have written in your spreadsheet so far, and do the following: 1. In cell B2, type the number 2. 2. In cell B3, type the number 3. Now it should look like Figure 13.
 
 Figure 13: Type the number 2 in cell B2 and the number 3 in cell B3.
 
 Then do the following: 3. Start by typing an = sign into cell B4 to show that you are about to write a formula. Do NOT type anything else, and do NOT press the ENTER key. 4. Take your mouse, point to cell B2 and click once with the left mouse button. Now the Formula Bar should show "= B2". 5. Press the + key on the keyboard. You are hopefully not surprised that it says "= B2 +" 6. Take your mouse again, point to cell B3, and click once with the left mouse button. Now it says "= B2 + B3" in the Formula Bar. 7. Press the ENTER key on the keyboard. If the computer did not break down it is now possible to create a formula that adds the values in cell B2 and B3 and displays the result 5 in cell B4. You should actually be able to write exactly the same formula in a different cell in the spreadsheet, so let us try it. 8. Choose an empty cell and type the following (without using the mouse): =B2+B3 9. And press ENTER. The result is of course the same, but now you have seen that you can freely choose between creating cell references by clicking with the mouse or typing them in directly. Each method has its advantages. When you click the mouse, you do not risk making typos but typing is often faster. The great thing about the formulas is that they keep working. If you change the numbers in cells B2 and B3 the results in the cells with formulas also change. So go ahead and try writing some other numbers in cell B2 and B3. I would suggest that you try writing some small formulas with references to get a little practice before we go any further. We have barely scratched the surface regarding formulas.
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 In the next section, we will try using some of Excel's built-in "functions" in our formulas. 3.2.1 References to Other Spreadsheets You are not limited to refer to cells in the same spreadsheet. In Excel you can have multiple spreadsheets in the same Excel file, and they are, as mentioned previously, organised in the "Sheet Tabs" at the bottom of the screen. If you refer to a cell in another worksheet, the reference must contain both a sheet reference and a cell reference. If you type a formula in Sheet1, that uses the value from cell B2 in Ark2, the reference must be”SHEET2’!B2”, not just ”B2”, which would be a reference to the sheet you are currently working in. You can also refer to cells in other spreadsheet files; we will return to that eventually.
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 3.3 Functions When I talk about "functions", I mean functions in formulas. These are not functions such as "Print" or "Save", but calculation functions. In the previous section you learned how to write simple formulas, where you could calculate with a few numbers. Functions enable you to add thousands of numbers together in an instant, calculate averages, make probability calculations and many other things. Functions are used in the formulas, and you can use several functions in the same formula. If we want to be really advanced we can even use functions within other functions, but we will not go that far yet. All functions in Excel are written in a certain way, which can be summed up in this manner Function name(arguments) All functions have a "function name". For example, the function that adds together numbers is called "SUM", and the function that calculates averages is called "AVERAGE". The Function Name is followed by one or more "Arguments", which are the numbers or cell references that feature must use in the calculation. If there is more than one argument in a function, they are separated by a semicolon ";". It looks like this: Function name(argument 1;argument 2;argument 3) Let us explore the most common functions, SUM and AVERAGE. 3.3.1 The SUM Function Now you will learn how to add together many numbers in an instant, but let us start with something simple. 1. Type the number 2 in cell B2 2. Type the number 3 in cell B3 3. Type the number 4 in cell B4 Now we will type a formula into cell B5 to add together the numbers in cells B2, B3 and B4. 4. In cell B5, write enter = SUM (B2; B3; B4). You will see that Excel colours the cell references and frames the corresponding cells in the same colour. It is helpful later when you work with more complicated formulas. 5. Press the ENTER key. Cell B5 should now show the result “9”. If it did not work, check that you remembered to write an equal sign at the beginning of the formula.
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 Figure 14: Writing a formula with the SUM function.
 
 You have written a formula with a SUM function with three arguments: the three cell references are separated by semicolons. Suppose you have to add together 1000 figures using cell references, that formula would be very long. It is, therefore, possible to use a "region reference" as an argument. A region reference consists of two cell references separated by a colon ”:”. Excel will add together the two cells AND all the cells between them. 1. Select cell B5 and press the F2 key on the keyboard. 2. Rewrite the formula so it reads =SUM(B2:B4 and press the ENTER key. Remember this time there should be a colon ”:” in the function, not a semicolon ”;”.
 
 Figure 15: SUM formula with region reference.
 
 The result is the same as last time, but you have now given one argument instead of three arguments, namely the region reference "B2: B4". Since cell B3 is between B2 and B4, it is part of the region that defines the calculation. If the list had has 1000 numbers that were to be added together instead of three, the formula would simply be called = SUM (B2: B1001). So now you know how to add together the 1000 numbers in an instant! By the way, the SUM function does not care if there are empty cells in the region specified. Now you have probably made an effort to write the formulas, just like I asked you to. I can tell you, that when you write formulas Excel is completely indifferent to whether you use uppercase or lowercase. So now you do not need to think about that anymore.
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 3.3.2 The AVERAGE Function The AVERAGE function is used exactly like the SUM function, but it calculates the average of the arguments instead. The nice thing about the AVERAGE function is that if there are empty cells in your arguments the AVERAGE function will ignore them. Remember in this context that an empty cell is not the same as a cell where there is a 0 value. Now we will write a formula with an AVERAGE function, similar to the SUM function we just had. But this time we will provide the region reference using the mouse in order to get a little practice. 1. Activate cell B6 and type =AVERAGE( 2. Using the mouse, point to cell B2, press the left mouse button and hold it down. 3. Move the mouse down in order to select cell B2, B3 and B4, then release the left mouse button. Now it should say =AVERAGE(B2:B4 4. Close the brackets ”)” and press ENTER. Cell B6 should now show the result 3.
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 4. Copying cells 4. Copying cells As in other Windows programs, you can also use "cut", "copy" and "paste" in Excel. You can copy a cell and
 
 As in the other Windows youThis can includes also use "cut", "copy" "paste" Excel. is You copy a cell and paste contents intoprograms, another cell. formulas. Butand copying andinpasting an can art in itself in Excel, paste contents into another cell. own This section includesinformulas. copying pasting is an at artfirst, in itself in Excel, whichthe is why this issue has its very the book.But It might be aand little confusing but once you which is why this issue has its very own section in the book. It might be a little confusing at first, but once you have learned it, it is a great help that Excel can "think" by itself when you copy, for example, a formula. have learned it, it is a great help that Excel can "think" by itself when you copy, for example, a formula.
 
 4.1 Simple Copying 4.1 Simple Copying With "Simple copying" I mean copying the contents from one cell to one or more other cells when the With "Simple copying" I mean contents fromwith oneformulas cell to one more the other cells when content is a simple number or a copying text. Youthe can copy cells in or exactly same way, butthe in the content is achapter simpleyou number or athat text.the You can copy cells formulas in exactly the same way, but in the following will see consequences are with a little different. following chapter you will see that the consequences are a little different. The first exercise is a simple copying of a cell. The first exercise is a simple copying of a cell. 1. Start with a blank worksheet. We need something to work with so type ”Something” in cell B2 and 1. Start a blank worksheet. We need something to work with so type ”Something” in cell B2 and press with ENTER on the keyboard. press ENTER on the keyboard.
 
 Figure 16: Type "Something" in cell B2. Figure 16: Type "Something" in cell B2.
 
 2. 2. 3. 3.
 
 Move the cursor back to cell B2, then copy the cell to the Windows Clipboard by either clicking the Move the cursor back to cellorB2, then copy the cell to the Windows Clipboard byand either clicking Copy button in the Ribbon by holding down the CTRL key on your keyboard pressing thethe C key. Copy button in the Ribbon or by holding down the CTRL key on your keyboard and pressing Move the cursor back to cell B3. Notice that there is now an animated dotted line around cellthe C key. Move the cursor to the cellcells B3. Notice theretoisthe now an animated cell B2. Excel alwaysback marks that arethat copied clipboard in thisdotted way. line The around highlight will B2. Excel always marks the cells that are copied to the clipboard in this way. The highlight will disappear as soon as you copy something else, write something in a cell or press the ESC key on disappear as soon as you else, write or something in athe cell or press on your keyboard. Click the copy Pastesomething button in the Ribbon hold down CTRL keythe on ESC your key keyboard yourpress keyboard. and the V Click key. the Paste button in the Ribbon or hold down the CTRL key on your keyboard and press the Vsay key. 4. Now it should ”Something” in both cell B2 and B3. 4. Now it should say ”Something” in both cell B2 and B3.
 
 This is the simplest form of copying. When you have inserted something, a small "copy button” appears next This the simplest of copying. When you have inserted something, small button” appears next to theiscell. Here youform can control various settings for the copy function, butawe will"copy not review it here. You to Here you canyou control settings for the copy function, but we will not review it here. You canthe trycell. it yourself once havevarious mastered the basics. can try it yourself once you have mastered the basics. We will try to copy cell B2 once more, but this time it will be copied to a lot of other cells. We will try to copy cell B2 once more, but this time it will be copied to a lot of other cells. 1. 1. 2. 2.
 
 If there is no longer an animated dotted line around cell B2, you must activate the cell and hold If therethe is CTRL no longer dottedwhile line around cell the B2,Cyou down keyan onanimated your keyboard you press key.must activate the cell and hold down the CTRL key on your keyboard while you press the C key. Make cell D2 the active cell. Hold down the Shift key on your keyboard and use the arrow keys to Make D2 theD2: active cell. Hold down you the Shift key on yourthe keyboard the arrow keys select cell the region G12. Alternatively can mark it with mouse,and but use I recommend once to select the region D2: G12. Alternatively you can mark it with the mouse, but I recommend once more that you get used to using the keyboard. more that you get used to using the keyboard.
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 3. Hold down the CTRL key on your keyboard and press the V key. 4. Now it says "Something" in cell region D2: G12 (Figure 17).
 
 Figure 17: Now we have made more copies Do you remember the section on the cell pointer and Auto fill? The Auto fill feature is located in the small black square in the lower right corner of the cell pointer. We will make a simple copy using it. 1. Activate cell B3. 2. Using your mouse, point ot the little black square in the lower right corner of the cell pointer. 3. Press the left mouse button and hold it down while moving the mouse down until you have selected 5 cells. 4. Release the left mouse button. Now you know the different ways you can perform a simple copying procedure. These methods are also used when copying cells with formulas.
 
 4.2 Series A series is a range of values that are linked. One example is the weekdays. After Monday comes Tuesday, and after Tuesday comes Wednesday. In my experience this never fails, and Excel knows this. Excel already knows the series for weekdays and months, but you can also define ranges yourself. Let us take a look at how it works. 1. Start with a blank spreadsheet and type ”Monday” in cell B2. 2. Ensure that cell B2 is the active cell. Using your mouse, point to the Auto Fill square in the lower right corner of the cell pointer. 3. Hold the left mouse button down and drag the mouse to cell B12, then release the mouse button. It should now look as shown in Figure 18.
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 Figure 18: We have inserted a series consisting of weekdays
 
 When there are no more elements in the series, it simply starts over. You can see that in cell 19, where Excel writes “Monday” anew.
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 4.2.1 Series with Numbers If you need to write a long row of numbers, Excel can also help. In this case there is no predefined series, but Excel tries to figure out what should be in subsequent cells from what you have already written. Let us make a five-times table. 1. 2. 3. 4.
 
 Start with a blank spreadsheet and type ”5” in cell B2. Type “10” in cell B3. Select the cell region B2:B3, using either the keyboard or the mouse. Point the mouse to the Auto Fill square. Keep the left mouse button down and drag the selection down to cell B11. Release the mouse button.
 
 You have now made a five-times table in no time!
 
 Figure 19: The five-times table.
 
 Excel does not always understand what you have in mind, so sometimes you may not get the result you want. But if you have a regular series of numbers, you can at least try Auto Fill first before you start typing numbers into cells manually. If it works as intended, it is faster and you do not risk typing errors. Try experimenting some more. You are not limited to starting with the values of only two cells. You can also try entering some initial values of three or more cells and see what happens. 4.2.2 Series that you define You can define your own series. It could be the alphabet or the sequence of the Fibonacci numbers. Let us try something simple. For example, if we write "First course", we would like Excel to continue with "Main Course", "Dessert" and "Coffee and brandy”. To define a series, we go into Excel’s Option. You enter Options by clicking on the big round Office Button in the upper left corner. At the bottom of the box that opens there is a button that says Excel Options. Click on that.
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 In the settings you can change lots of things to make Excel work differently. I would not recommend that you start changing a lot until you are fairly familiar with the program because here it is possible to mess things up pretty badly.
 
 Figure 20: Inside Excel Options.
 
 However, it is not "dangerous" to define your own series. Click Edit Custom Lists to get into the series. Excel uses the terms "series" and "lists" somewhat interchangeably, so do not let that confuse you. Now you should be inside the same window as in Figure 21. There are two panes; one is an overview of the various lists you can choose, and the second shows the contents of the list you have selected.
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 Figure 21: The ”Lists” box
 
 As mentioned above, Excel already has some pre-defined lists for weekdays and months. These lists cannot be erased or altered, but the lists you create you can do with what you want.
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 Let us make the list - or series if you prefer. 1. 2. 3. 4. 5. 6. 7. 8.
 
 In the left pane, click on NEW LIST. Click with left mouse button in the right pane. Type First Course and press ENTER on the keyboard. Type Main Course and press ENTER on the keyboard. Type Dessert and press ENTER on the keyboard. Type Coffee and Brandy, then press ENTER on the keyboard. Click on the Add button, now you can see your list in the left pane. Click OK to close the ”Lists” window, then OK again to close “Excel Options”.
 
 Now your list is hidden discretely in the background until you decide to use it. We want to try it now, so let us start in a blank worksheet and type “First Course” in cell B2.
 
 Figure 22: Our series put to practical use.
 
 Now grip the mouse tightly, click on the AutoFill square and drag the mouse either down or to the right, then release the mouse button. If you dragged the mouse down, it will look like Figure 22.
 
 4.3 Copying Formulas You have now learned the basics of how to copy a cell. Copying cells with formulas is done in exactly the same way, but there are some things in the formulas that you must learn to control. Excel will help you when you copy, so you do not need to edit the formulas that follow. Excel also does different things when you copy and when you cut cells with formulas, but we will return to that in due course. Let us first get some material to work with. Let us imagine that we have a very small company who sell miracle cures against dry skin, and we want to calculate the monthly profits.
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 1. Make a spreadsheet exactly identical to what you see in Figure 26.
 
 Figure 23: The starting point of the exercise.
 
 The monthly surplus should appear in cell C5, D5 and E5, so we start by calculating the surplus for the month of January. 2. In cell C5, type “=C3-C4” and press ENTER. Cell C5 should now show the result 250. 3. Now copy cell C5 to cell D5 and E5 as described in the section Simple Copying. The Result should be identical to the one in Figure 24.
 
 Figure 24: If you have done everything correctly it will look like this.
 
 Note that Excel has calculated the surplus for February and March correctly as well. This is because it has automatically moved the references. If you select cell D5 and look at the formula bar, you can see that the formula is "= D3-D4" and not "= C3C4", as you wrote in cell C5. As a starting point, Excel works with something called ”relative references”, which means that the cell references are changed accordingly when you copy a cell with a formula to another location. This applies only when you copy the cell. If you instead cut cells and paste them somewhere else, the original cell references will be retained.
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 4.3.1 Relative and Absolute References When you copy formulas, the concepts "relative" and "absolute" references are important to know. Let us continue our little exercise in which we must now calculate with a fixed monthly expense. 1. 2. 3. 4.
 
 In the spreadsheet, we are already working with, type “rent of storage” in cell G3. Type ”300” in cell H3. Type ”rent of storage” in cell B7, and type ”Surplus” after ” rent of storage in cell B8. Change the text in cell B5 to ”Surplus” before ”rent of storage”.
 
 You will probably have to adjust column width in some places to display it all. You have now prepared a spreadsheet as shown in Figure 28 5. In cell C7, type ”=H3” and press ENTER. It now says you have $50 for rent in January. 6. Now copy cell C7 to cell D7 and E7, using one of the methods we have been practicing.
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 No, you are not doing anything wrong – the cells are supposed to display 0! If you click on cell 7, you can see that in the formula bar it says ”J3”. This is a case where relative references cannot be used. Instead we must use an absolute reference. 7. In cell C7, type ”=$H$3” and press ENTER. 8. Copy cell C7 to cell D7 and E7. Now it says 300 in all three cells. The dollar sign "locks" a row or column, so that the reference will always be for that row or column, no matter where we copy the cell to. Try clicking on cell C7, then click the formula in the formula bar so you can edit it. Now try pressing F4 a few times. With F4 you can add and remove dollar signs in the cell reference. Of course you can also just type the dollar signs the usual way. Let us try another exercise, this time with the Multiplication Table. 1. Create a new spreadsheet as shown in Figure 25.
 
 Figure 25: Making the Multiplication Table.
 
 The idea of the Multiplication Table is that you can see the result if you multiply a number in the top row with a number in the left column. So let us make some formulas to calculate each cell. 2. In cell C3, type ” =C2*B3” and press ENTER. We know from first grade that 1 times1 equals 1, so everything seems fine so far. 3. Copy cell C3 to the region C3:L12 and let us see what happens. Be prepared for a less than pretty sight!
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 Once again it is the relative references that are tricking us. Some sums are calculated incorrectly. Some cells even show the value "# NUM!", Which means that the number is too large for Excel to calculate! Other cells, like cell F6, display cryptic values, such as ”1.1E+11”. That is because the number in itself is too large to show in the normal way. In the case of ”1.1E+11” it means that you must multiply 1.1 with 1011. Or to put it differently, you must multiply 1.1 with 100.000.000.000 (11 zeros)
 
 Figure 26: This is what it looks like when you have copied cell C3 to the entire region. There is definitely something wrong!
 
 Take a look at the formulas in the individual cells. Because of the relative references, it is not the numbers in row 2 that are multiplied with the numbers in column B. We need change to change that! 4. In cell C3, type ”=C$2*$B3” and press ENTER. 5. Copy cell C3 to the entire region C3:L12 once more. Now the table should look like Figure 27
 
 Figure 27: The Multiplication Table as it is supposed to look.
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 This time we have used the dollar signs to lock row 2 and column B respectively, so they now have become absolute references. If this is clear you are now in a good position to move forward. The concepts of relative and absolute references are ones that many people find difficult, so if you have not understood it yet, I recommend you put the book aside for today and sleep on it. Tomorrow you can calmly read this section once more and do the exercises without haste. Trust me, you will get it eventually
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 You are now familiar with the basic concepts of Excel, and you can make spreadsheets. Later in the book we will proceed with more advanced functions and formulas, but it is probably time we learned to make it all look a little more inviting.
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 5. Formatting So far we have not worried about getting everything to look neat and attractive, so that is what we are going to do now. Unless you simply want to make a little simple calculation for yourself, you should consider the formatting of the spreadsheet. If you need to make a large, complex spreadsheet that other people are going to use, you should be aware that, while the construction might appear logical to you, it can be difficult for others to understand the logic. Appropriate formatting also indicates quality and credibility. There are a myriad of options for formatting in Excel. You can change row and column sizes, font types and sizes, colours, number formats, etc. You can even format the cells so that they change colour depending on their value!
 
 5.1 Text and colours You are free to format text and numbers in cells and give them colours. You can format multiple cells at once as long as you make sure they are selected first. Many functions in Excel can be found in several ways. The main ways to find a function are by means of the Ribbon, "contextual menus" or shortcut keys. 5.1.1 Formatting using the Ribbon Most features for text formatting are located in the ”Ribbon”. Let us practice a little. 1. Try typing your name in a cell. 2. Ensure the cell is active. The Ribbon is organised into different Tabs. You need the tab labelled "Home", where you find the formatting functions. Please refer to Figure 28.
 
 Figure 28: Text formatting in the Ribbon.
 
 The buttons in the Ribbon are divided into groups. The group where we find the most important buttons is "Font" group.
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 3. Click on the button
 
 . The text will likely become red.
 
 Figure 29: There are many colours to choose between.
 
 If you have played around with it previously, the text may get a different color, since there are several possibilities. This button has a little arrow on the right side giving access to more options. 4. Try clicking on the small arrow on the button. This gives you the opportunity to choose between several colours. Click on one of the blue hues. Your text is now blue. You can also format multiple cells at once. 5. Highlight the cell with your name plus some more cells. 6. Click on the button in the Ribbon. Now you have a yellow background. Just as with the text, you could also have chosen a different colour. 7. If you are still not satisfied, you can click on More Colours, and choose from up to 16 million different colours. That should be enough for most people! 8. Click the little arrow on the right button. This button is what we call the "Font Changer". Your font changer might display another font than "Calibri", but you do not risk ruining anything by clicking on it anyway! 9. You are about to select another font, so try, for example ”Arial Black”. 10. To the right of the font changer there is a button where you select the font size. Try for example 24. That will make the text much larger. Try some of the other buttons to discover their effect. 5.1.2 Formatting using the shortcut menu Modern Windows programs rely largely on the shortcut menus that pop up when you click on something with your right mouse button. In the shortcut menu you find the most frequently used functions related to what you have just clicked on.
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 1. Type you name in a cell and press ENTER. 2. Click on the cell with the right mouse button to display the ”shortcut menu”.
 
 Figure 30: A right-click with the mouse makes the shortcut menu appear.
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 3. Click on the menu item Format Cells This will give you access to all the options available to format one or more cells. A dialog box opens, and you can choose between different Tabs at the top. 4. Select the Font, Tab and the following window appears:
 
 Figure 31: Here you can set the font.
 
 5. Select the font size and color that suits you, then click the Fill Tab. You can choose to fill the cell with a fill colour, a pattern or a colour effect. We have already tried a normal fill colour, so let us try something with effects! 6. Click on the Effects button and a new window will open.
 
 Figure 32: Effect colour.
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 In Excel the effect colours consist of two colours which gradually blend into each other. 7. Try choosing colours by clicking on Colour 1 and Colour 2. 8. Try clicking on the different Shading Types. When you are satisfied, click OK. 9. Click OK again. My little experiment turned out thus:
 
 Figure 33: My own experiment.
 
 5.1.3 Borders and Frames When you look at a blank worksheet, there are some thin lines that indicate where the cells are. Without these lines it would be harder to identify a particular cell in the sheet. But these "grid lines" are only auxiliary lines; they are not written out unless you specifically request it, and if you provide some cells with a fill colour, grid lines will not be displayed in that area. But you can add borders and frames yourself, and you can even choose the colour and how thick they should be. 1. Select cell region B2:E5. 2. Click with the right mouse button inside the area and select Format Cells. 3. Select the Border Tab in the dialog box that appears. Now we need to make some grid lines. We would like to have a thick border around the selected area and some thin grid lines that show the cells inside the area. It is actually very easy to do, but it is quite difficult to explain because you must click in many different places in the correct order. I have therefore made the following illustration that shows what you need to click and in what order.
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 Figure 34: The approach used to make grid lines and frames in the selected area.
 
 The window is divided into three groups of objects you can click on. The first group is "Line" where you choose how your edges should look and what colour they should have. The next group is the "Presets", where you can choose between None, Contour and Interior.
 
 your chance Please click the advert
 
 to change
 
 the world Here at Ericsson we have a deep rooted belief that the innovations we make on a daily basis can have a profound effect on making the world a better place for people, business and society. Join us. In Germany we are especially looking for graduates as Integration Engineers for • Radio Access and IP Networks • IMS and IPTV We are looking forward to getting your application! To apply and for all current job openings please visit our web page: www.ericsson.com/careers
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 The function None is relevant if you have already made some lines that you want removed. The Contour function makes a frame around the selected cell region with the line you have chosen. The Interior function draws lines inside the selected cell regions, which highlights the individual cell. The final group in the dialog box is "Border", where you can do exactly the same thing as in the group "Presets". The difference is that here you can control exactly which lines you want. For example, you can settle for a thick line at the top and bottom of the marked area or you can choose to have only horizontal interior lines. Let us see how it works. We will follow the numbering in Figure 38. 1. First, click the thick line. 2. Choose a colour. 3. Click on Contour. You have now defined the frame around the selected area. 4. Click on the thin line. 5. Choose a colour as in point 2, but preferably a second colour for illustration 6. Click on the button for interior horizontal lines. If you wish, you can choose another line type and colour before you proceed to point 7 7. Click OK. Your result hopefully looks like mine in Figure 35
 
 Figure 35: Frame and gridlines have been added.
 
 Now you should have a good insight into the possibilities for colouring your worksheet. Colours can have a large impact. If used right, they can make a complicated spreadsheet much more logical, simple and inviting. I use formatting for larger spreadsheets, although I may be the only one who needs them. For example, I almost always colour cells with formulas, while I keep cells without formulas white. In this way I can quickly see which numbers are the ones being entered and which are the calculated values.
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 5.2 Number Formats We will now leave the department of colours and stripes and return to numbers. Numbers can be displayed in many ways. Which of the following numbers do you think is most readable? 1000000 or 1.000.000 If the figure referred to money, one million could also be written as "kr 1,000,000.00. In other cases you might be interested in controlling how many decimal places to display. This you also control via formatting. 1. Type the figure 123456 in cell B2. 2. Click with the right mouse button on the cell and choose Format Cells. 3. Click on the Number Tab if it has not been selected already.
 
 Now we can choose between a lot of different number formats. In the pane "Category" you can choose between the basic types, and depending on what you choose, different options will appear. Try clicking on the different types, so you get an idea of the possibilities before we proceed. Do not click OK. Click on the category Number, which will make the dialog box look like Figure 36.
 
 Figure 36: Formatting numbers.
 
 4. At Number Of Decimal Places, choose ”1”. 5. Put a check mark by Use Thousands Separator. This means that periods are inserted in the number, like the example with 1.000.000 instead of 1000000. 6. Click OK.
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 Figure 37: The number has been formatted.
 
 Now your number looks like Figure 37. The figure remains the same, but it appears in a different way. Please note that, although only one decimal place is displayed, all decimals are still counted. You will see that if you look at the formula bar when the cell is selected. Number formats have no bearing on the cell value. 7. Type 25% in cell B4 and press ENTER. In this case Excel assists a little with the number format because it actually displays "25%". What you are not able to see is that the cell's value is actually 0.25. You can discover that by changing the number format to a number with two decimal places. If you wish, you can try it.
 
 Please click the advert
 
 what‘s missing in this equation?
 
 You could be one of our future talents
 
 MAERSK INTERNATIONAL TECHNOLOGY & SCIENCE PROGRAMME Are you about to graduate as an engineer or geoscientist? Or have you already graduated? If so, there may be an exciting future for you with A.P. Moller - Maersk.
 
 www.maersk.com/mitas
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 Figure 38: By changing the number format it is shown that 25% is the same as 0.25.
 
 5.3 Date and Time You can write the date and/or time in several ways. When you type a date and/or time, Excel automatically formats the cell to an appropriate date or time format. All you have to do is type it in correctly. Dates will be recognised if you write them in one of the following ways: 25-3-2008 or 25/3/2008 Times will be recognised if you write them in one of the following ways: 17:45 (hours:minutes) 17:45:30 (hours:minutes:seconds). Date and time can of course also be combined by putting spaces in between, for example: 25-03-2008 17:45:30 You can perform calculations with dates and times. Excel uses a clever numbering system to keep track of dates and times. When there is a date and/or time in a cell, the cell just has a numerical value that is formatted as date/time. This could lead to headaches if it were to be used in a calculation, but it is pretty simple. Excel's calendar begins on January 1 1900, 00.00. This time point has the value "1". January 2 1900, 00:00, has the value "2”.
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 In other words, For each day 1 is added. The time is also part of this system, so January 2 1900 at 12.00 noon, has the value "2.5". One hour thus corresponds to 1/24, or 0.041666667 to be precise. Actually, Excel operates with 10 decimal places, so you can calculate with very accurate time points.
 
 5.4 Formatting Tables When working with a spreadsheet, one usually makes tables. Once you have made a table where you have inserted sum formulas, etc., Excel can format the table automatically, so it looks neat and presentable.
 
 Figure 39: Create a table like this.
 
 1. Create a table like the one in Figure 39. 2. Ensure that one of the cells in the table is the active one. 3. In the Ribbon, make sure that the ”Home” Tab has been selected. Then Click on the Format As Table button in the Ribbon. 4. A menu will pop up and you can choose a table layout 5. A small box will appear and ask what region you wish to define as the table. It is usually right on target if you have done as I have shown. 6. Finally you must also make sure to put a marker in the My Table Has Headers box, which ensures that the column headers are highlighted. 7. Click OK. Now your table should have been formatted with the highlighted title and everything. You can still change the formatting of individual cells if you like. My table came to look like this:
 
 Figure 40: My table looks like this.
 
 But formatting of the table is not the only thing that has happened. In addition to formatting the table, the Ribbon at the top has changed, and you now see a range of functions that relate to the tables. A Tab has been added in the Ribbon, which is available when you activate a cell in the table. That is because the tables in Excel are not only about the formatting. There are some special options when you define specific areas of a worksheet as tables, which we will return to later in the book.
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 Figure 41: The Ribbon changes when you format a table.
 
 But it is not the only thing that has happened; some arrows have appeared beside the column headers. These arrows can be used as "filters", where you can select specific data that you want to see. It has no relevance to a table like the one we just created, but if you work with a table with many data covering hundreds of lines it can be very practical. If you print the worksheet, the arrows do not show on the printout, but you can also remove the arrows by disabling the filter. To disable the filter, do as follows:
 
 Turning a challenge into a learning curve. Just another day at the office for a high performer. Please click the advert
 
 Accenture Boot Camp – your toughest test yet Choose Accenture for a career where the variety of opportunities and challenges allows you to make a difference every day. A place where you can develop your potential and grow professionally, working alongside talented colleagues. The only place where you can learn from our unrivalled experience, while helping our global clients achieve high performance. If this is your idea of a typical working day, then Accenture is the place to be. It all starts at Boot Camp. It’s 48 hours that will stimulate your mind and enhance your career prospects. You’ll spend time with other students, top Accenture Consultants and special guests. An inspirational two days
 
 packed with intellectual challenges and activities designed to let you discover what it really means to be a high performer in business. We can’t tell you everything about Boot Camp, but expect a fast-paced, exhilarating
 
 Visit accenture.com/bootcamp
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 1. Select the Data Tab in the Ribbon. 2. Click on the Filter button. It is easy to find because at present the filter is active, which means the button is highlighted with a red/orange colour.
 
 Figure 42: Excel is being "creative" by inserting column headers.
 
 Now the arrows have disappeared from the column headers, but there has also been another change in the table. In the upper left corner it suddenly says "column1". I wondered the first time I saw this in Excel 2007, since I had never seen it before. The explanation is that when you define a field as a table Excel requires that all columns have a header. This is because Excel will use the headlines in connection with the sorting and filtering features that are available for tables. This is also the reason you cannot delete the text. You can write anything you want, but Excel does not allow this cell to be empty. I you want it to be empty anyway, I have a little ”trick” for you. 1. Activate the cell. 2. Press the spacebar on the keyboard. 3. Press the ENTER key on your keyboard Now you have typed an empty space in the cell, and spaces are invisible.
 
 5.5 Conditional Formatting Excel can change the colour, font, etc. of a cell, depending on what value it has. You can pre-select a number format that shows negative numbers in red, but conditional formatting gives more options. The way it works is that you give a cell the format you would like it to have as a starting point. Then you set up a list of the alternative formats it can have, and what conditions must be met for it to change the format. Imagine an example where you want to build up statistics on absenteeism rates among a group of employees. You make a list of employees and a calculation of absence rates. If the absence rate for the individual employee is less than 5%, the cell should have default formatting. If absence rates are greater than 5% but less than 8%, the cell should be marked with a yellow background colour. If the absenteeism rate is 8% or more, the cell should have white writing on a red background colour. If you have worked with conditional formatting in earlier versions of Excel, this may not be new to you. But Excel 2007 has introduced a new way to define rules. It has now become much easier. In addition, it has become possible to use a value-dependent colour spectrum, which can give quite impressive results.
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 Figure 43: Starting point for the exercise with conditioned formatting
 
 Let us try a couple of exercises. 1. Create a spreadsheet as in Figure 43. 2. Select the cell region B2: E6. The selected cells will be included in the conditional formatting. 3. Ensure that the “Home” Tab has been selected in the Ribbon and click the Conditioned Formatting button. 4. In the menu that appears, point to “Top/Bottom Rules” to make a submenu appear. 5. Click on Top 10%. This means that those 10% of the cells that have the highest values will be highlighted. You will now have the opportunity to fine-tune the formatting. A dialog box will appear where you can change the rate distribution. For example, you might want to highlight the cells with the top 20% values. You also have the opportunity to choose between several predefined formattings by clicking on the list in the dialog box. If you select Custom Format on the list, you can fine-tune the format and choose exactly what colours you want. 6. Select Light Red Fill With Dark Red Text . 7. Click OK. Now the cells with the two highest values should be selected. In my case it looks like this:
 
 Figure 44: Conditioned formatting where the top 20% values have been highlighted
 
 Figure 45: The Formatting changes if you change the values.
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 8. Try typing the number 21 in the cell with the value 7. This will make the highlight disappear from the cell with the value 19, because now the cells with the values 20 and 21 constitute the top 10%. 9. 10. 11. 12.
 
 Select all the cells again. Select the Conditioned Formatting button again. Point to Highlight Cell Rules to make a submenu appear. Click on Between, which gives us the opportunity to highlight cells with values within a certain range. 13. In the dialog box that appears, write 15 in the first field and 20 in the second field. 14. Choose the format Yellow Fill With Dark Yellow Text. 15. Click OK.
 
 If you have followed my instructions to the letter, your spreadsheet now looks like this: Now you have two different conditional formatting that work in the same cells. First, the top 10% of cells are coloured pink, and then the cells with values between 15 and 20 are coloured yellow. The conditions operate in the order you created them. It was the yellow formatting that was created last, therefore the cell with the value 20 is also yellow, although it was previously pink.
 
 Please click the advert
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 16. Ensure the cell region we have been working with so far is selected. 17. Click on the Conditioned Formatting button again. 18. Choose the menu item Administer Rules in the menu that appears.
 
 Figure 46: Rule management for conditioned formatting You now have the ability to manage the order of the rules you have set up for conditional formatting. You can also add, delete or modify rules. In this exercise we just need to reverse the order. 19. Ensure that the rule for Cell Value between 15 and 20 has been chosen. 20. Click on the Move Down button. It looks like this: 21. Click OK.
 
 .
 
 Now you spreadsheet looks like this:
 
 Figure 47: Now the cell med the value "20" has become pink again.
 
 Now the rule is applied to highlight the top 10% values last, so cell E6 has become pink again. There are many other possibilities for conditional formatting. It is, for example, possible to give the cell a hue from pale yellow to deep red, depending on how high the value is. Many of these options arguably belong to the "extra icing on the cake" category, but they can also be used to make the spreadsheet more readable.
 
 5.6 Themes and Styles Themes and Styles is a new option in Excel 2007, but you probably recognise Styles from Word and PowerPoint, where they have been used in many earlier versions.
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 Use of Themes and Styles helps you make "nice" worksheets where you can easily create a uniform and neat appearance. As you might have noticed by now, I like to emphasise that the spreadsheet should do more than just calculate correctly. If you are building large and complicated spreadsheets to be used by anyone other than yourself, it is important that it is logical and clearly structured, and preferably nice to look at. When it is neat and easy to understand, there will not be so many mistakes. It will also make it more credible. If you got good grades for your arithmetic homework in school, you probably know what I mean. If you did not get good grades, it might be a consolation that Excel now can assist you. Themes can be regarded as an overarching set of guidelines for the fonts and colour combinations you can use in your spreadsheet. You can even define your own Themes, but Excel comes with many predefined Themes where the colours already match nicely. A Theme defines for example that all header cells must have green background colour and be written in bold type, while cells with formulas should be bright green. If you change the Theme for the entire worksheet, the changes will be reflected in all the cells to which you have assigned a "Style". A style is something you assign to each cell. You can for example define that cell B2, C2 and D2 are headings in a table, while the cells below are general number-cells. At the bottom you might have calculated a sum, in which case you can give the lower cells the style "Calculation". Let us see how it works. 1. Start with a blank spreadsheet and create a table as shown in Figure 48. The table does not really make sense and is only meant as an example.
 
 Figure 48: The starting point for the exercise.
 
 We start by assigning a "theme" to the spreadsheet. This theme will affect our subsequent formatting of the spreadsheet. 2. Choose the Page Layout Tab in the Ribbon and click on the button furthest to the left, called Themes (Figure 49). 3. A menu will appear where you can choose between various different themes. Click on the Sequence theme.
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 Figure 49: Choosing theme.
 
 At the moment there are few visible changes in the spreadsheet. Only the font in the cells has changed.
 
 Brain power Please click the advert
 
 By 2020, wind could provide one-tenth of our planet’s electricity needs. Already today, SKF’s innovative knowhow is crucial to running a large proportion of the world’s wind turbines. Up to 25 % of the generating costs relate to maintenance. These can be reduced dramatically thanks to our systems for on-line condition monitoring and automatic lubrication. We help make it more economical to create cleaner, cheaper energy out of thin air. By sharing our experience, expertise, and creativity, industries can boost performance beyond expectations. Therefore we need the best employees who can meet this challenge!
 
 The Power of Knowledge Engineering
 
 Plug into The Power of Knowledge Engineering. Visit us at www.skf.com/knowledge
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 4. Select the cell region C2:E2. 5. Choose Home Tab in the Ribbon and click on the Cell Styles button.
 
 Figure 50: Choosing Cell Style.
 
 When you click the Cell Style button, a menu will appear where you can choose from a variety of named Styles. When you point to the individual Styles with your mouse, you can see how it will look in your table. 6. 7. 8. 9. 10.
 
 Click on the Style Heading 1. Select cell region B3:B8. Click the Cell Styles button and choose the style Accent1. Select cell region C8:E8. Click on the Cell Style button and choose the Calculation Style.
 
 If you have done as I, your spreadsheet will look like this:
 
 Figure 51: Table with Styles.
 
 Now we will try some other colours, but we do not want to format the individual cells again so we will choose a different colour theme. Select the Page Layout Tab in the Ribbon, then click the Themes button Search. Click on the theme Sumptuous (anything less will not do!).
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 Now your spreadsheet looks like this:
 
 Figure 52: Spreadsheet wtth the the “Sumptuous”.
 
 Now you have been introduced to Themes and Styles, and you can now experiment with them on your own. If you continue working with Themes and Styles, you may also find that when you insert charts, graphs etc., they will also have colours defined in the colour theme you have chosen, and so it all fits together.
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 6. 6. Working Working with with Tables Tables
 
 Basically everything in Excel is tables, except the diagrams. A spreadsheet is itself a large table. When I talk Basically everything in Excel is tables, except the diagrams. A spreadsheet is itself a large table. When I talk about tables, I mean defined regions in the spreadsheet with a group of data. This group of data has some about tables, I mean defined regions in the spreadsheet with a group of data. This group of data has some column headers and maybe, but not necessarily, some row headers. column headers and maybe, but not necessarily, some row headers. We have already worked a little with tables in connection with formatting. If you have read the section on We have already worked a little with tables in connection with formatting. If you have read the section on formatting tables, you might remember that several things happened beyond giving the table some nice formatting tables, you might remember that several things happened beyond giving the table some nice colours. colours.
 
 6.1 Create a Table 6.1 Create a Table The starting point for the exercises in this book is a small list of different movies that I have in my DVD The starting point for the exercises in this book is a small list of different movies that I have in my DVD collection. The list should perhaps include 150 movies, but I am pretty sure that in that you would not want collection. The list should perhaps include 150 movies, but I am pretty sure that in that you would not want to do the exercise! to do the exercise!
 
 Please click the advert
 
 We therefore confine ourselves to five films, which should be enough to get an understanding of working We therefore confine ourselves to five films, which should be enough to get an understanding of working with tables. With so few rows, it seems foolish to make grades and filterings, but I will ask you to imagine with tables. With so few rows, it seems foolish to make grades and filterings, but I will ask you to imagine that we are doing the same with a long list. that we are doing the same with a long list.
 
 The ﬁnancial industry needs a strong software platform That’s why we need you SimCorp is a leading provider of software solutions for the ﬁnancial industry. We work together to reach a common goal: to help our clients succeed by providing a strong, scalable IT platform that enables growth, while mitigating risk and reducing cost. At SimCorp, we value commitment and enable you to make the most of your ambitions and potential. Are you among the best qualiﬁed in ﬁnance, economics, IT or mathematics?
 
 Find your next challenge at www.simcorp.com/careers
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 If you have a collection of movies, music or anything else, you could make a small index of it afterwards to practice what you have learned in this section. 1. To get some material to work with in the following exercises you must create a spreadsheet similar to the one shown in Figure 53. You are probably going to have to adjust the width of the columns to be able to view all of it.
 
 Figure 53: Starting point for the exercise.
 
 2. Place the cursor, so one of the cells inside the table is the active cell. 3. In the Ribbon, ensure the Home Tab is selected, then click the button Format as Table. 4. Click on a table colour. You have now created your table.
 
 Figure 54: Sample table. Note that the Ribbon at the top has changed.
 
 This table is the starting point for several exercises to come.
 
 6.2 Filtering Once you have created a table, you have to use filters on it. You use filters to select and show certain data in the table, according to criteria which you have defined. Excel operates with two different types of filters called "AutoFilter" and "Advanced Filter".AutoFilter is readily available in the column headings when you have defined a table. Advanced Filter requires a little more work, but it also gives you more options. In practice AutoFilter is by far the easiest to use, and it can deal with most tasks. Advanced Filter is preferable if you want to filter your table based on values in cells outside of the table you are filtering.
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 6.2.1 AutoFilter The AutoFilter is located at the top of the table in the headers. As you may have noticed, a button has appeared next to each heading. By clicking the buttons you will have access to AutoFilter. In our exercise, we want the table to show pre-1990 Danish films. The approach is that we look at which columns contain data that we want to find. Then we take one column at a time and define the criteria for it. 1. Click on the arrow to the right of the header ”Language”. A menu will appear, where you have different options relating to sorting and filtering the column, Do not choose any of the sorting options yet; we will look at that later.
 
 Figure 55: Filtering options.
 
 In the menu that appeared you can also see a list of all the values you have typed into the ‘Language” column. In our case it is ”Danish” ”English” and ”German”. At the moment there’s a ”tick” next to all three values, which means we have not filtered anything out yet. 2. Click on the selection by Select All to make the markers disappear. 3. Then insert a marker by English. Now it should only be "English", that is marked, as in Figure 60 4. Click on OK. You have created the first filter, so you are shown only Danish film titles. The other films are still there, but they are hidden at the moment. Notice the spreadsheet row numbers on the left side. Row
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 Figure 56: Now only Danish film titles from the list are shown.
 
 4, 5 and 7 are not displayed, and the rows that contain filtered data are shown in blue row numbers. When row numbers are blue, it means that a filter is active. It also means that you must think carefully if you want to create two tables with different filters side by side. Excel hides the entire row in the worksheet when a cell value does not satisfy a given criterion. So if you have a second table standing next to the table you are filtering, you may inadvertently hide data in it. The aim of our exercise was to find pre-1990 Danish film titles, so we need to filter by year. To filter by year before 1990, we have to define a "custom filter". 5. Click on the small arrow next to the header ”Year” 6. In the menu that appears, point to Number Filters. 7. A submenu will appear. Click on Less Than to open a dialog box.
 
 What do you want to do? Please click the advert
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 Figure 57: The Filter "Less than ".
 
 In the dialog box you must indicate that you want to see the rows of the table where the year is “less than’ 1990. The dialog box allows you to specify two different criteria, but in this exercise we only use one.
 
 Figure 58: Custom filter.
 
 8. Fill out the dialog box as shown in Figure 58 and click OK. Now we have used filters on the columns, ”Language” and ”Year”, and the result should look like Figure 59:
 
 Figure 59: The result of our exercise with filters.
 
 After all the hard work creating the filters we must remove them again. Fortunately, it is fairly easy, and it can be done in two ways. The first method is to remove the filters individually from each column. We will try with ”Year”. 9. Click on the filter button next to the header ”Year”. 10. In the menu that appears, click on Remove Filter From ”Year”
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 Figure 60: Remove a filter.
 
 Now the two Danish movies in our collection are shown again. The other way of removing filters is used to remove all filters at once. 11. Make one of the cells in the table the active cell. 12. In the Ribbon, click the Data Tab. 13. Click the Filter button. It is easy to find because it will be yellow/orange at this point.
 
 Figure 61: The filter button is easy to find.
 
 The filters have been removed and all the rows in the table are shown again. 6.2.2 Advanced Filter The Advanced Filter works in a completely different way than the AutoFilter. In the Advanced Filter you must create an additional table named "criteria range" with the same column headings as the table that you want to filter. In the extra table you must specify the criteria and tell Excel where to find the criteria. Finally, you must also indicate whether you want the table filtered by hiding rows, or by writing the results elsewhere in the spreadsheet. The latter option means you do not have any hidden rows. In this exercise, we continue working with the list of our small film collection. Again, it seems extremely foolish to filter a table with five rows, but it is easier to understand the different concepts when we only have little data to work with.
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 First we must make some space above the table for our Criteria Range. At least three blank rows above the table are required for the criteria range, since there are some rules that must be observed to make it work:  The Criteria Range should have column headings, and it must be the same as the column headings in the table to be filtered.  The Criteria Range should have room for at least one row of criteria.  There must be at least one empty row acting as the space between the criteria range and the table to be filtered. In this exercise, there should be room for three series of criteria, so we must have five blank rows above the table to make room for it all. We can either do this by simply moving the table four rows down, or by inserting four empty rows above it. We choose the latter. 1. Click with the right mouse button on the column heading for row ”1”. A menu will pop up. 2. Click on Insert (Not to be confused with Paste, ). You have now added an empty row at the top. We need three more, but since I was born lazy and want to teach you some small tweaks, we will not repeat the same procedure again.
 
 Please click the advert
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 3. Hold the CTRL key on the keyboard down and press the Y key three times. When you hold down the CTRL key and press the Y key, you use the command ”Repeat last action”. It works for many commands, and in all MS-Office programs. It also works in many other programs. Now your spreadsheet looks like this:
 
 Figure 62: Now there is room for the criteria range.
 
 Now we need some column headings for the criteria range, Since they are the same as in the table, we can just copy those. 4. 5. 6. 7.
 
 Select cell region B6:F6. Hold the CTRL key on the keyboard down and press the C key. Activate cell B1. Hold the CTRL key on the keyboard down and press the V key.
 
 Your spreadsheet should now look like Figure 63:
 
 Figure 63: The criteria range with column headings.
 
 Now we can define some criteria, but I would like to try to explain how the criteria range works, because it is not always easy to grasp. As mentioned, the criteria range is designed as a table with rows and columns. The columns have headings that correspond to those in the table that is to be filtered according to the criteria. There is obviously a reason why you can write multiple rows of criteria, namely that you can put "AND" or "OR" between the criteria.
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 Criteria with ”AND” in between are placed in the same row Criteria with ”OR” between are placed in separate rows. An example in our table could be that we want to display rows in the table containing films that are Danish AND prior to1990. 7. Type the word ”Danish” in cell D2. 8. Type ”					    
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